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A. Giới thiệu 
DataPro là hệ thống phần mềm cung cấp dữ liệu chứng khoán, hỗ trợ nhà đầu tư phân 
tích kỹ thuật một cách nhanh chóng và ổn định nhất hiện nay. Với nền tảng công nghệ tiên 
tiến, DataPro đảm bảo độ chính xác và tốc độ cập nhật dữ liệu vượt trội, giúp người dùng 
có được thông tin thị trường một cách kịp thời và hiệu quả. 

DataPro kế thừa công nghệ cập nhật dữ liệu xuất sắc từ hệ thống bảng giá chứng khoán 
stockprice.vn, mang đến trải nghiệm mượt mà và đáng tin cậy cho nhà đầu tư. Hệ thống 
này phù hợp với cả các nhà giao dịch cá nhân và tổ chức, cung cấp các công cụ hỗ trợ 
phân tích kỹ thuật toàn diện để tối ưu hóa chiến lược đầu tư. 

A.I. Đặc điểm nổi bật 
DataPro phiên bản 5.0 là một hệ thống hoàn toàn mới so với phiên bản 1.0 với 
những cải tiến nhằm tăng tốc độ cập nhật dữ liệu và đạt được độ chính xác cao:  

-​ Cung cấp dữ liệu chứng khoán mạnh mẽ, hỗ trợ phân tích kỹ thuật với tốc 
độ cập nhật nhanh và ổn định. Sử dụng hệ thống kết nối tân tiến, DataPro 
nâng cao đáng kể tốc độ nhận và xử lý dữ liệu, đảm bảo thông tin thị trường 
luôn sẵn sàng cho nhà đầu tư. 

-​ Tùy chọn dữ liệu linh hoạt: Hỗ trợ dữ liệu 1 phút hoặc 5 phút, phù hợp với 
nhu cầu phân tích khác nhau. 

-​ Cộng khối lượng thỏa thuận: Tùy chọn gộp Khối lượng thỏa thuận vào Khối 
lượng, giúp phản ánh chính xác hơn thanh khoản thị trường. 

-​ Mã phụ đa dạng: Tích hợp các thông tin bổ sung như Khối lượng mua, Khối 
lượng bán, Nước ngoài mua/bán, Khối lượng thỏa thuận, giúp nhà đầu tư có 
cái nhìn chi tiết hơn. 

-​ Tùy chọn dữ liệu linh hoạt: Hỗ trợ dữ liệu 1 phút hoặc 5 phút, phù hợp với 
nhu cầu phân tích khác nhau. 

-​ Hiệu chỉnh dữ liệu tự động: Hệ thống tự động hiệu chỉnh dữ liệu nhanh 
chóng, đặc biệt cung cấp dữ liệu Intraday đã hiệu chỉnh, giúp nhà đầu tư yên 
tâm sử dụng. 

-​ Xem bảng giá nhanh và chính xác: Cập nhật bảng giá tổng hợp, thống kê 
theo sàn với tốc độ ngang bằng với StockPrice.vn. 
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A.II. Gói dịch vụ 
DataPro cung cấp 4 gói dịch vụ linh hoạt, đáp ứng nhu cầu từ cơ bản đến nâng cao 
của nhà đầu tư: 

○​  BRONZE – Gói cơ bản: Cung cấp quyền truy cập đầy đủ vào bảng giá trên 
website với tất cả chức năng, phù hợp với những ai cần dữ liệu tổng hợp mà 
không yêu cầu xử lý chuyên sâu. 

○​ SILVER – Gói tiêu chuẩn:Cung cấp dữ liệu EOD cho tất cả mã chứng khoán 
trên ba sàn (HOSE, HNX, UPCOM) cùng toàn bộ thông tin của các chỉ số 
chính và phụ như:  

○​ VNINDEX. 
○​ HNXINDEX. 
○​ UPCOMINDEX. 
○​ VN30INDEX. 
○​ HNX30INDEX. 
○​ V.v. 

​ ​ ​ Đây là lựa chọn phù hợp cho nhà đầu tư phân tích thị trường theo dữ liệu 
cuối ngày. 

○​ GOLD – Gói nâng cao:Ngoài dữ liệu EOD, gói này bổ sung dữ liệu Intraday 
dưới dạng các bar 1 phút, giúp nhà đầu tư có cái nhìn chi tiết hơn về biến 
động thị trường trong phiên. 

○​ DIAMOND – Gói cao cấp:Cung cấp dữ liệu Intraday dưới dạng các bar 1 tick, 
cho phép theo dõi từng biến động nhỏ nhất của giá, phù hợp với những nhà 
đầu tư chuyên nghiệp hoặc giao dịch thuật toán cần dữ liệu có độ phân giải 
cao nhất. 
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B. Hướng dẫn cài đặt 

B.I. Cài đặt DataPro 
​  (Nhập đường liên kết: https://datapro.vn/ vào trình duyệt web 

 để truy cập website và thực hiện các bước cài đặt dưới đây) 
 

Bước 1.​ Nhấn vào nút "Cài đặt ngay" để tải về và bắt đầu quá trình cài đặt phần 
mềm. 

 
Bước 2.​ "Nếu quá trình tải về bị gián đoạn do phần mềm diệt virus chặn (vì ứng 

dụng chưa được sử dụng phổ biến), vui lòng tạm thời tắt phần mềm diệt virus 
hoặc thêm ứng dụng vào danh sách cho phép để tiếp tục tải về. 
 

Bước 3.​ Sau khi tải xuống hoàn tất, mở tệp cài đặt vừa tải xuống, nếu hiển thị 
thông báo như hình bên dưới thì hãy chọn "More info" như trong hình 
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Bước 4.​ Sau đó hãy chọn "Run anyway" để tiếp tục cài đặt 

 
 

Bước 5.​ Chọn "Yes" nếu hiển thị cửa sổ UAC (bỏ qua nếu như không gặp phải) 

 
 

Bước 6.​ Sau đó cửa sổ cài đặt sẽ hiện ra như hình bên dưới nếu không có nhu cầu 
thay đổi thư mục lưu phần mềm hãy nhấn "Next" để tiếp tục bước tiếp theo 
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Bước 7.​ Chọn tạo lối tắt để hiển thị phần mềm tại desktop sau đó chọn "Next" 

 
 

Bước 8.​ Sau đó chọn "Install" để bắt đầu cài đặt 
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Bước 9.​ Đợi quá trình cài đặt hoàn tất chọn "Finish" để hoàn tất và khởi động 
Datapro 
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B.II. Cập nhật phiên bản mới 
Bước 1.​ Phần mềm hiển thị thông báo cập nhật như bên dưới, hãy chọn "Yes" để 

bắt đầu quá trình cập nhật. 

 
 

Bước 2.​ Sau đó, vui lòng quay lại và thực hiện lại các bước trong phần B.I. Cài đặt 
DataPro, bắt đầu từ "bước 5", để tiếp tục quá trình cập nhật và đảm bảo phần 
mềm được thiết lập đúng cách. 
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B.III. Sử dụng bản Portable 
​ ​ Lưu ý: Bản cài đặt sẵn Portable không tự động cập nhật phiên bản mới. Tính năng 

cập nhật phiên bản phần mềm mới chỉ có ở Cài đặt trên. Mỗi khi có 
phiên bản mới, vui lòng truy cập https://datapro.vn/ để tải  
bản mới nhất. 

 
Bước 1.​ Chọn "Tải bản Portable (Không cần cài đặt)", ngay bên dưới nút Cài đặt 

ngay. Trình duyệt sẽ tải xuống file nén Portable.zip. 

 
 

Bước 2.​ Mở thư mục lưu file đã tải về, giải nén bằng cách nhấp chuột phải vào file 
nén và chọn "Extract to Portable" như hình bên dưới. 

 
 

Bước 3.​ Sau khi giải nén truy cập vào thư mục vừa được giải nén, sau đó chạy 
file"DataPro.Client.exe" để chạy chương trình. 
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B.IV. Cài đặt Amibroker và kết nối Plugin  
​ Chú ý: Plugin này chỉ chạy trên Amibroker 32 bit phiên bản 5.3 trở lên.​  

Tải về Amibroker từ: https://datapro.vn/s/AmiBroker 6.2.zip 
dán vào trình duyệt web để tải về và thực hiện các bước cài đặt dưới đây 

B.IV.I. Cài đặt Amibroker: 
Bước 1.​ Sau khi đã tải về thực hiện giải nén chọn "Extract here" như hình 

bên dưới  

 
 

Bước 2.​ Truy cập vào AmiBroker 6.2, tìm đến file Broker.exe nhấn chuột phải 
chọn tạo shortcut ra ngoài Desktop 

 
 

Bước 3.​ Sau đó, truy cập vào Desktop, sao chép thêm shortcut Broker. Tiếp 
theo, đổi tên một shortcut thành "Broker.exe - EOD" và shortcut còn lại thành 
"Broker.exe - Intraday", theo hình bên dưới. 
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Bước 4.​ Tiếp theo nhấn chuột phải vào  "Broker.exe - EOD" chọn Properties 

và làm theo hình bên dưới 

 
​ ​  

Bước 5.​ Tại cửa sổ Properties Shortcut > Target hãy thêm vào cuối chuỗi: 
a.​  /database "dp_d" (đối với EOD) 

b.​  /database "dp_m" (đối với Intraday) 
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B.IV.II. Kết nối Plugin: 
Bước 1.​ Kiểm tra Plugin đã được kết nối hay chưa, mở Amibroker sau quá 

trình cài đặt sẽ có thông báo về plugin đã được kết nối thành công và được tô 
màu xanh như hình bên dưới. 

 
 

Bước 2.​ Nếu không có chữ "DataPro" hoặc chữ này không được tô màu 
xanh thì phải tiến hành kết nối Plugin thủ công theo các bước sau. Thoát 
hoàn toàn Amibroker nếu đang mở, mở DataPro và truy cập vào cửa sổ 'Cấu 
hình hệ thống'. Thực hiện các bước theo đúng thứ tự hướng dẫn bên 
dưới để hoàn tất quá trình kết nối Plugin: 
 

a.​ Chọn thư mục Plugins trong folder Amibroker đã cài. 
 

b.​ Nếu Amibroker đang sử dụng là phiên bản "64 bit" thì hãy nhấn nút 
"▼" và chọn đúng phiên bản đang sử dụng, mặc định là 32 bit. 
  

c.​ Sau đó nhấn "Lưu"và khởi động lại Amibroker 
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C. Hướng dẫn sử dụng 

​ C.I. Đăng ký tài khoản 
​ ​ Lưu ý:  Có hai cách để đăng ký tài khoản mới, cả hai cách này đều có thể sử dụng  

cho cả DataPro và StockPrice (bảng giá). 

​ ​ C.I.I Đăng ký trên trang stockprice.vn 
​ ​ Truy cập vào đường dẫn http://stockprice.vn sau đó chọn "Đăng nhập" > "Tạo tài khoản mới" : 

 
​  
Vui lòng nhập đầy đủ các thông tin được yêu cầu, nhấn nút "Đăng ký ngay" để hoàn tất 
sau đó kiểm tra Email để xác nhận đăng ký. 
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​  

C.I.II Đăng ký trên ứng dụng DataPro: 
​ ​ ​ Sau khi đã cài đặt và mở DataPro và chọn Đăng ký ngay: 

 
​  
Vui lòng nhập đầy đủ các thông tin được yêu cầu, nhấn nút "Đăng ký ngay" để hoàn tất 
sau đó kiểm tra Email để xác nhận đăng ký. 
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C.II. Đăng nhập hệ thống & Quên mật khẩu 
​ ​ Lưu ý: Sử dụng tài khoản đã đăng ký như bước trên để hoàn tất đăng nhập. 

 [Tên đăng nhập] là tài khoản người dùng đã tạo tại bước C.I. Đăng ký tài khoản 
(không lẫn với email) 

 
​  

-​ Chọn "Lưu mật khẩu" cho lần đăng nhập sau để lưu lại mật khẩu đã nhập. Sau lần đăng 
nhập đầu tiên thành công, hệ thống sẽ lưu thông tin đăng nhập cho lần sau. Từ lần đăng 
nhập sau người dùng không phải nhập các thông tin này nữa. 
Khi mật khẩu đã được lưu, lần chạy phần mềm sau đó hoặc kết nối với máy chủ bị ngắt 
thì phần mềm sẽ tự động kết nối lại. Tuy nhiên, trừ 2 trường hợp sau mà phần mềm sẽ 
không tự kết nối lại khi bị ngắt khỏi máy chủ: người dùng chủ động ngắt kết nối hoặc tài 
khoản này được đăng nhập từ một máy khác. 
 

-​ Bấm nút "thay đổi ngôn ngữ" để chọn ngôn ngữ sử dụng phù hợp. Chú ý rằng khi chọn 
ngôn ngữ, phần mềm sẽ chạy lại. 

​ ​ ​
​ ​  
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Quên mật khẩu: chọn nút quên mật khẩu tại màn đăng nhập 

 
 

Để đặt lại mật khẩu, bạn cần nhập Tên đăng nhập hoặc Email vào ô yêu cầu, sau đó nhấn 
nút "Gửi". Hệ thống sẽ kiểm tra thông tin và nếu hợp lệ, một email chứa mật khẩu mới 
sẽ được gửi đến địa chỉ email của bạn. Hãy kiểm tra hộp thư đến (hoặc thư rác nếu không 
thấy email) và đăng nhập với mật khẩu mới. 

 
 

 
 

​  
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C.III. Ẩn cửa sổ chính  
​ ​ Tổng quan: 

-​ Khác với các phiên bản trước, khi người dùng thu nhỏ cửa sổ chính, phần 
mềm sẽ không thoát hoàn toàn mà chỉ ẩn đi. Kết nối đến máy chủ vẫn được 
duy trì, đảm bảo dữ liệu tiếp tục được cập nhật. 

-​ Bắt đầu từ phiên bản 2.0, khi phần mềm chạy, một biểu tượng (icon) sẽ 
xuất hiện trên khu vực trạng thái (status area) của Windows, giúp bạn dễ 
dàng quản lý và truy cập nhanh vào phần mềm. 
 

-​ Phần mềm chỉ thực sự thoát khi người dùng chọn "Thoát" trên cửa sổ hoặc 
nút đóng "X" trên phần mềm. 

-​ Khi bấm chuột phải vào biểu tượng Datapro trên khu vực trạng thái thì một 
menu sẽ hiện ra cho phép người dùng điều khiển một số chức năng cơ bản 
của phần mềm mà không phải hiện đầy đủ cửa sổ chính. 

-​ Chức năng "Hiện cửa sổ" cho phép hiển thị lại cửa sổ chính của phần mềm 
khi đang ẩn. Ngược lại, khi "Ẩn cửa sổ", phần mềm sẽ tiếp tục chạy ngầm 
mà không thoát hoàn toàn. 
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C.IV. Menu chính 

​ ​ C.IV.I Hệ thống 
​ ​ Tại nút "Hệ thống" nhấn chuột để hiển thị menu hệ thống có hình như sau.  

Menu này chứa các chức năng để điều khiển chung: 

 
 

1.​ "Đăng xuất", giúp người dùng ngắt kết nối với máy chủ và kết thúc phiên làm việc hiện 
tại.Khi đăng xuất, phần mềm sẽ dừng nhận và cập nhật dữ liệu từ máy chủ.Nếu muốn tiếp 
tục sử dụng, bạn cần đăng nhập lại bằng tài khoản của mình. 
 

2.​ "Đổi mật khẩu", cho phép người dùng thay đổi mật khẩu đăng nhập để tăng tính bảo 
mật.Khi chọn "Đổi mật khẩu", bạn cần nhập mật khẩu hiện tại, sau đó nhập mật khẩu 
mới và xác nhận lại.Hệ thống sẽ yêu cầu mật khẩu đáp ứng các tiêu chuẩn bảo mật, 
chẳng hạn như độ dài tối thiểu hoặc ký tự đặc biệt. 
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3.​ "Change language", giúp thay đổi ngôn ngữ giao diện giữa Tiếng Anh và Tiếng 
Việt.Khi chọn ngôn ngữ mới, hệ thống sẽ cập nhật toàn bộ giao diện, menu, thông báo sang 
ngôn ngữ đã chọn. 
 

4.​ "Cấu hình hệ thống" phần mềm sẽ hiển thị mục [Thông số], nơi người dùng có thể nhập 
hoặc thay đổi các tùy chọn cài đặt. Chức năng này giúp bạn điều chỉnh các thông số 
quan trọng như đường dẫn dữ liệu, loại dữ liệu, khởi tạo… 

A.​ Thông số chung:  

 
 

A.1: Chức năng này cho phép người 
dùng chọn thư mục trên máy tính để 
lưu trữ dữ liệu. Việc chọn đúng thư 
mục sẽ giúp hệ thống lưu trữ và truy 
xuất dữ liệu nhanh hơn, đảm bảo hiệu 
suất tốt nhất khi sử dụng. 
 
Khuyến nghị: Nên chọn ổ cứng SSD 
để tăng tốc độ đọc/ghi và cải thiện hiệu 
năng xử lý dữ liệu. 

A.2: Chức năng này cho phép người 
dùng chọn loại dữ liệu cần khởi tạo, 
bao gồm: 

●​ EOD (End of Day) – Dữ liệu cuối 
ngày. 

●​ Intraday – Dữ liệu trong ngày. 
●​ Tick – Dữ liệu từng giao dịch. 
●​ All – Khởi tạo toàn bộ dữ liệu 

(mặc định). 
●​  

Khi nhấn nút "Khởi Tạo", hệ thống sẽ tự 
động chọn "All" nếu người dùng không 
thay đổi lựa chọn. 

 

A.3: Chức năng này cho phép người 
dùng lựa chọn khung thời gian dữ 
liệu để theo dõi, bao gồm: 
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●​ 1M (1 phút) – Dữ liệu chi tiết 
theo từng phút, phù hợp với 
giao dịch nhanh. 

●​ 5M (5 phút) – Dữ liệu tổng hợp 
mỗi 5 phút, giúp giảm nhiễu và 
tối ưu phân tích. 
 

Người dùng có thể chuyển đổi nhanh 
giữa 1M và 5M để phù hợp với nhu cầu 
theo dõi. 

A.4: Cho phép chọn thư mục lưu plugin 
và cập nhật plugin theo phiên bản 32-bit 
hoặc 64-bit (mặc định là 32-bit). 

​ ​ ​  
B.​ Dữ liệu: 

 
​ ​ ​ ​  

B.1: Cho phép lọc các mã chứng khoán 
theo sàn giao dịch, loại mã, thị 
trường quốc tế hoặc ngành để dễ 
dàng theo dõi và phân tích. 

B.2: Cho phép lọc các mã chứng khoán 
dựa trên danh sách các mã chứng 
khoán đang theo dõi.  
Giúp người dùng dễ dàng tìm kiếm và 
tập trung vào những mã quan tâm nhất. 
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C.​ Metastock: không tự động cập nhật khi có dữ liệu mới, vì vậy cần sử dụng một phần 

mềm độc lập để cập nhật dữ liệu, đảm bảo rằng các biểu đồ và chỉ báo trong 
Metastock luôn được làm mới với dữ liệu chính xác và kịp thời 

 
 

C.1: Chọn nếu muốn sử dụng dữ liệu 
cho phần mềm Metastock. 

C.2: Tải Refresher để cập nhật dữ liệu 
cho Metastock. 
 

 

C.3: Tự động chạy Refresher khi chạy 
Datapro. 

 

C.4: Nhấn để mở và chạy Refresher 
Hướng dẫn sử dụng Refresher trong 
phần: C.V. Metastock 
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D.​ Proxy: Cho phép hệ thống gửi và nhận dữ liệu qua một máy chủ trung gian (proxy 
server), thay vì kết nối trực tiếp với internet hoặc nguồn dữ liệu. Điều này giúp kiểm 
soát và bảo mật kết nối, hoặc giúp vượt qua các hạn chế mạng (chẳng hạn như 
tường lửa, vùng địa lý bị khóa). 

 
 

D.1: Chọn nếu muốn sử dụng kết nối 
qua Proxy 

D.2: Chức năng này cho phép người 
dùng thiết lập và sử dụng proxy mặc 
định với hai trường thông tin chính: 

●​ Địa chỉ (IP hoặc tên miền): Xác 
định máy chủ proxy cần kết nối. 

●​ Cổng (Port): Cổng giao tiếp của 
proxy, thường do nhà cung cấp 
proxy quy định. 

D.3: Chức năng này cho phép người 
dùng nhập thông tin xác thực proxy, 
bao gồm tên proxy, mật khẩu proxy và 
tên miền proxy, để kết nối qua máy chủ 
trung gian, đảm bảo truy cập mạng an 
toàn và ổn định. 
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C.IV.II Tài khoản 
​ ​ Tại nút "Tài khoản" nhấn chuột để hiển thị menu tài khoản có hình như sau.  

Menu này chứa các chức năng liên quan đến tài khoản: 

 
 

1.​ "Tài khoản": Giúp xem chi tiết tài khoản 
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A.​ "Đổi hạng": giúp thay đổi gói hiện tại sang gói cao hoặc thấp hơn gói hiện tại 

 
B.​ "Lịch sử gia hạn": Hiển thị thông tin về ngày gia hạn, thời gian hiệu lực, số tiền 

thanh toán và phương thức gia hạn. Cho phép tìm kiếm theo tên dịch vụ, mã hợp 
đồng, ngày gia hạn, hoặc trạng thái. Lọc dữ liệu: Lọc theo khoảng thời gian hoặc 
loại gia hạn. 
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B.1: Tạo đơn hàng mới 

 

B.2: Chọn và hủy đơn hàng  
 

 
C.​ "Đổi địa chỉ Email": Cho phép người dùng cập nhật địa chỉ email mới thay thế email 

cũ trong hệ thống, sau khi cập nhật sẽ có mail gửi về email cũ vui lòng xác nhận 
theo hướng dẫn trong mail được gửi về. 
Email mới sẽ được sử dụng cho các mục đích như đăng nhập, nhận thông báo, khôi 
phục tài khoản, v.v. 
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2.​ "Tặng ngày sử dụng": Cho phép người dùng chuyển số ngày sử dụng dịch vụ 
của mình cho người khác. Đây là cách giúp bạn bè hoặc người thân tiếp tục 
sử dụng dịch vụ mà không cần mua thêm. 

 
 

3.​ "Gia hạn": Cho phép người dùng kéo dài thời gian sử dụng dịch vụ bằng cách mua 
thêm số ngày sử dụng hoặc gia hạn gói hiện tại. Điều này giúp tránh gián đoạn dịch vụ 
khi sắp hết hạn. 

a.​ Hạng: Chọn loại hạng muốn gia hạn chi tiết hạng có thể xem trên A.II.Gói dịch vụ 
b.​ Gói dịch vụ: chọn gia hạn gói theo năm hoặc theo tháng 
c.​ Mã khuyến mại: Nhập mã khuyến mại để được giảm % giá tương ứng 

 
 

4.​ "Lịch sử gia hạn": Hiển thị thông tin về ngày gia hạn, thời gian hiệu lực, số tiền thanh toán 
và phương thức gia hạn. Cho phép tìm kiếm theo tên dịch vụ, mã hợp đồng, ngày gia 
hạn, hoặc trạng thái. Lọc dữ liệu: Lọc theo khoảng thời gian hoặc loại gia hạn. 

​ ​  
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C.IV.III Dữ liệu 
Tại nút "Dữ liệu" nhấn chuột để hiển thị menu tài khoản có hình như sau.  
Menu này chứa các chức năng liên quan đến dữ liệu: 

 
 

1.​ "Tải lại tên chứng khoán": cho phép người dùng cập nhật lại tên của toàn bộ mã chứng 
khoán đang theo dõi. Điều này giúp đảm bảo danh sách luôn hiển thị đúng tên, không bị lỗi 
hoặc thiếu dữ liệu khi có thay đổi từ thị trường. 
 

2.​ "Xem dữ liệu", Hiển thị cửa sổ xem dữ liệu 

 
 

 
Chức năng này cho phép người dùng chọn 
khung thời gian dữ liệu (ví dụ: 5M, 1D...). 
Nếu hệ thống đang lấy loại dữ liệu 5M. 
Ngược lại, nếu chọn loại dữ liệu khác, nút 
tương ứng sẽ thay đổi theo.  

 Chức năng này cho phép người dùng chọn 
một mã chứng khoán, sau đó hệ thống sẽ 
hiển thị sàn giao dịch và loại chứng khoán 
tương ứng của mã đó. Điều này giúp người 
dùng dễ dàng nhận diện thông tin quan 
trọng về mã đang theo dõi. 
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Chức năng này cho phép người dùng chọn 
khoảng thời gian dữ liệu của một mã 
chứng khoán để phân tích hoặc theo dõi. 
Các tùy chọn thời gian gồm: 

●​ 3 ngày 
●​ 1 tuần 
●​ 2 tuần 
●​ 6 tháng 
●​ 1 năm 
●​ Tất cả (Toàn bộ lịch sử dữ liệu có 

sẵn) 

 
3.​ "Xem dữ liệu Metastock", Hiển thị cửa sổ xem dữ liệu của Metastock 

 
​ ​ ​  

 

Chức năng này cho phép người dùng tạo lại 
dữ liệu mới nhất khi gặp sự cố về dữ liệu 
hiển thị (thiếu, sai lệch hoặc lỗi). Khi nhấn 
nút "Tạo Lại", hệ thống sẽ xóa dữ liệu cũ 
và tải lại thông tin mới nhất. 

Các thông tin về mã đã chọn  

​ ​ ​  
 

​ ​  
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C.IV.IV Thông báo & Trợ giúp 
Tại icon như trong hình nhấn chuột để hiện danh sách các thông báo từ hệ thống: 
Mã mới lên sàn, thông báo mã khuyến mại, thông tin gia hạn… 
 

1.​ Nhấn vào tin bất kỳ để xem được chi tiết của thông báo  

​ ​  
2.​ Nhấn vào nút xem thêm để hiển thị và xem toàn bộ thông báo  
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C.V. Amibroker 

​ ​ C.V.I Mô tả cấu hình hệ thống 

 

-​ Use English: Khi chọn tên của mã chứng 
khoán được đổi thành tiếng anh 
 

-​ Auto Refresh: Tự động làm mới khi có 
dữ liệu 
 

-​ Ignore Non Trading Bars: Bỏ qua những 
mã chứng khoán không có giao dịch 
 

-​ Types: Chọn lấy dữ liệu theo loại: 
○​ STOCK (Cổ phiếu) 

 
○​ CW  (Chứng quyền có bảo đảm) 

 
○​ ETF (Quỹ hoán đổi danh mục) 

 
○​ DERIVATIVES (Phái sinh) 

 
○​ FUND (Quỹ đầu tư) 

 
○​ INDICES (Chỉ số chứng khoán) 

 
-​ Exchanges: Chọn lấy dữ liệu theo sàn: 

○​ HNX (Chứng khoán Hà Nội) 
 

○​ HSX (Chứng khoán TP.HCM) 
 

○​ GLOBE (Thế giới) 
 

○​ UPCOM (Chưa niêm yết) 
 

○​ INDUSTRIES (Chỉ số ngành) 
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-​ Create Sub Symbols: Chọn tạo mã phụ 
với các thông tin sau: 

○​ Val (Tổng khối lượng giao dịch) 
 

○​ Buy_Val, Sell_Val (Tổng giá trị 
mua vào, bán ra) 
 

○​ Buy_Vol, Sell_Vol (Tổng khối 
lượng mua vào, bán ra) 
 

○​ Frn_Buy_Val, Frn_Sell_Val (Tổng 
giá trị mua vào, bán ra của nhà 
đầu tư nước ngoài.) 
 

○​ Frn_Buy_Vol, Frn_Sell_Vol ( Tổng 
khối lượng cổ phiếu mua vào, 
bán ra bởi nhà đầu tư nước 
ngoài.) 
 

○​ Pt_Vol (Tổng khối lượng giao 
dịch thỏa thuận) 
 

○​ Pt_Val (Tổng giá trị giao dịch 
thỏa thuận) 
 

○​ Port_Buy_Val, Port_Sell_Val 
(Tổng giá trị mua vào, bán  của 
nhà đầu tư tổ chức) 
 

○​ Port_Buy_Vol, Port_Sell_Vol 
(Tổng khối lượng mua vào, bán 
ra của nhà đầu tư tổ chức) 
 

○​ OI (Tổng số hợp đồng phái sinh 
đang mở) 

 
​  
​ ​ Sử dụng nút "Retrieve symbols" để tại lại các mã chứng khoán đang có,  

nút "Save configuration" để lưu thông tin chỉnh sửa. 
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Để truy cập vào cấu hình hệ thống có 2 cách như sau: 
Cách 1.​ Nhấn chuột phải vào đoạn văn bản "Datapro" ở góc dưới bên phải như trong 

hình, sau đó chọn "Configure" 

​ ​ ​  
Cách 2.​ Nhấn vào "File" > "Database settings" 

​ ​ ​  
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Tại cửa sổ "Database settings" chọn "Configure" 

 
1.​ Lưu ý: nếu bạn đang theo dõi dữ liệu trên DatPro với khung 1 phút, bạn cũng cần 

đặt Amibroker ở khung thời gian 1 phút để đảm bảo dữ liệu khớp nhau. Nếu bạn 
chọn khung 5 phút trên DatPro, bạn cũng phải đặt Amibroker ở 5 phút để tránh sự 
sai lệch dữ liệu giữa hai phần mềm 
 

2.​ Khi bạn nhấn vào nút "Configure", bạn sẽ mở được phần cài đặt của hệ thống. 

​ ​  
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B.V.II. Cập nhật mã mới: 
Bước 1.​  Nhấn vào "File" > "Database settings" 

 
​ ​ ​  

Bước 2.​ Tại cửa sổ "Database settings" chọn "Configure" 

 
Bước 3.​ Sau đó sử dụng nút "Retrieve symbols" để tải lại các mã chứng khoán đang có 
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C.V.III Cách thay đổi Plugin 
Nhấn vào "File" > "Database settings". Tại cửa sổ "Database settings" chọn 
 "Configure" 

 
Sau đó chọn Ok để sử dụng Plugin 
  

C.V.IV Hướng dẫn sử dụng của Amibroker 
​ ​ ​ Chọn "Help" > "Help Contents" để có thể đọc được hướng dẫn sử dụng Amibroker 
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​ C.VI. Hướng dẫn thanh toán 
●​ Mở Thông tin gia hạn: Sau khi tạo "Yêu cầu gia hạn" hoặc double click vào 1 dòng gia hạn 

trên "Lịch sử gia hạn" phần mềm hiển thị màn hình "Thông tin đơn hàng" 

 
​ ​  

A.​ "Số ngày sử dụng": Là số ngày mà người dùng được gia hạn thêm khi thực hiện chuyển 
tiền thành công để thanh toán yêu cầu gia hạn này 
 

B.​ "Số tiền thực trả": Là số tiền mà người dùng phải thanh toán 
 

C.​ "Trạng thái": Là trạng thái của Yêu cầu gia hạn, bao gồm các trạng thái Chờ duyệt, Đã 
duyệt, Đã hủy 
 

D.​ "Chuyển tiền": Chức năng chuyển tiền online, chỉ được kích hoạt khi trạng thái là "CHỜ 
DUYỆT" 

 
 
 
 
 

​ ​  
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C.VI.I. Thanh toán qua mã qr bằng các App Ngân hàng 
Bước 1.​ Bấm vào nút chuyển tiền qua tài khoản, hệ thống hiển thị và tạo ra mã qr 

với nội dung và số tiền thanh toán tương ứng 

 
Bước 2.​ Kéo xuống dưới để xem mã QR, sau đó dùng ứng dụng ngân hàng VCB, ACB, 

TCB, BIDV hoặc ví điện tử để quét mã và hoàn tất thanh toán nhanh chóng. 
Lưu ý: kiểm tra đúng nội dung sau đó xác nhận chuyển khoản. 
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C.VI.II. Thanh toán qua Ngân lượng 
-​ Ngoài cách chuyển tiền truyền thống trực tiếp cho DataPro, người sử dụng có thể chuyển 

tiền online qua Ngân lượng. Sử dụng kênh thanh toán này, yêu cầu gia hạn của bạn sẽ 
được kích hoạt ngay sau khi bạn thực hiện chuyển tiền thành công. 

-​ Chú ý: Đối với các khách hàng có tài khoản cùng ngân hàng với các tài khoản mà DataPro 
cung cấp thì nên chuyển tiền truyền thống. Do tiền phí Ngân lượng thu theo giá trị giao dịch 
nên cao hơn so với chuyển cùng ngân hàng Cụ thể các bước như dưới đây:   

Bước 3.​ Bấm vào nút chuyển tiền qua ví điện tử hệ thống sẽ chuyển đến trang 
website chuyển tiền đến ngân lượng. 

 
Bước 4.​ Các phương thức chuyển tiền qua ngân lượng: 

A.​ Chuyển tiền bằng ví ngân lượng: 
Lưu ý: Bạn cần phải có tài khoản của Ngân lượng khi dùng phương thức này. Bạn 
nên sử dụng khi ví ngân lượng của bạn đủ số dư để thanh toán, vì phương thức này 
được miễn phí giao dịch 
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Sau đó đăng nhập trên website hoặc trên ứng dụng Ngân lượng, làm theo các bước 
hướng dẫn của Ngân lượng để tiếp tục thanh toán: 

 
 

 
B.​ Chuyển khoản ngân hàng, Thẻ ATM nội địa: Chọn ngân hàng mà bạn đang muốn 

chuyển tiền đi từ đó, ví dụ Vietcombank 

 
 

 

© 2025 datapro.vn · Tất cả các quyền được bảo lưu · Trang 40/53 

 



D
at
aP
ro

 

 

 

 
 

Sau khi chọn nhập các thông tin và xác nhận thanh toán, hệ thống sẽ tự động nhập 
tên và email, người dùng cần điền nốt các thông tin còn lại để tiếp tục thanh toán. 

 
 
​ ​ ​ ​  
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Nhập Thông tin thẻ ATM: 

 
 

C.​ Qua App Mobile Banking (VIETQR NAPAS247): Chọn ngân hàng mà bạn đang 
muốn chuyển tiền nhập thông tin và quét mã qr trên app để xác nhận chuyển khoản 

 
​ ​ ​ ​ Quét mã và làm theo hướng dẫn: 
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D.​ Online bằng Internet Banking: Chọn ngân hàng mà bạn đang muốn chuyển tiền 

nhập thông tin và quét mã qr trên app để xác nhận chuyển khoản 

 
 

Nhập mã xác nhận và tiếp tục 

 
​ ​ ​ ​  
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Hệ thống sẽ chuyển qua trang Website ngân hàng đã chọn cùng với đơn hàng, đăng 
nhập sau đó tiếp tục thanh toán. 

 
​ ​ ​ ​  

 

​  
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C.VII. Metastock 
​ ​ Tải về Metastock từ:   https://datapro.vn/s/EMSProV11.rar 

dán vào trình duyệt web để tải về và thực hiện các bước cài đặt dưới đây 

C.VII.I. Cài đặt Metastock: 
Bước 1.​ Sau khi đã tải về thực hiện giải nén chọn "Extract here" như hình 

bên dưới: 

 
 

Bước 2.​ Sau khi giải nén xong mở thư mục "EMSProV11" lên, tại đây đúp chuột vào 
trình cài đặt "MSeSignal110ProSetup.exe" để bắt đầu quá trình cài đặt. 

 
 

Bước 3.​ Chọn "Setup". 
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Bước 4.​ Chọn "Next". 

 
 

Bước 5.​ Tick chọn "I accept this agreement" rồi chọn "Next". 
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Bước 6.​ Điền lần lượt vào 3 ô 1, 2, 3 các đoạn tương ứng Y328, M7UL, NCJNJ rồi chọn 

"Next". 

 
 

Bước 7.​ Thông báo dưới đây sẽ hiện lên và chọn "Yes". 
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Bước 8.​ Chọn "Browse" để thay đổi thư mục cài đặt sau đó chọn "Next". 

 
 

Bước 9.​ Chọn "Standard" sau đó chọn "Next". 
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Bước 10.​ Chọn "eSignal" rồi chọn "Next". 

 
 

Bước 11.​ Để lựa chọn mặc định là "Equis International" rồi chọn "Next". 
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Bước 12.​ Chọn 1 trong 2 lựa chọn rồi chọn "Next". 

 
 

Bước 13.​ Chọn các phần mềm muốn hiển thị lên trên màn hình rồi chọn "Next". 
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Bước 14.​ Chọn "Finish" để hoàn thành cài đặt. 

 
 

Bước 15.​ Quay lại thư mục "EMSProV11" mở thư mục "crack", sau đó sao chép 
"MsWin.exe". 

 
 

Bước 16.​ Mở thư mục bạn chọn lưu thư mục cài đặt đã chọn ở bước 8 nơi chứa 
"MsWin.exe" sau đó dán file "MsWin.exe" sao chép ở bước trên ghi đè lên. 
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D. Một số tình huống thường gặp 

​ D.I. Không có dữ liệu cập nhật, đèn vàng nháy 
Bước 1.​ Bấm đúp chuột vào "Đèn vàng" để mở file log 

 
Bước 2.​ Kiểm tra log, nếu có ghi ra lỗi có mô tả "The database file is locked" hoặc "The 

database disk image is malformed" 
 

Bước 3.​ Thực hiện khởi tạo lại dữ liệu, không cập nhật được dữ liệu nào thì khởi tạo lại dữ liệu 
đó 

​ D.II. Các chức năng và trạng thái phần mềm 

 
Cho phép người dùng tải lại dữ liệu mới nhất từ hệ thống, giúp cập nhật thông 
tin nhanh chóng khi có thay đổi. Khi nhấn, hệ thống sẽ xóa dữ liệu cũ, lấy dữ 
liệu mới và hiển thị kết quả mới nhất. 

 
Chức năng này cho phép người dùng xuất dữ liệu từ hệ thống ra file Excel 
(.xlsx hoặc .csv) để lưu trữ, phân tích hoặc chia sẻ. Khi nhấn nút "Xuất Excel", 
hệ thống sẽ tạo file Excel với dữ liệu hiện tại và tệp thư mục lưu. 

 

Chức năng này cho phép người dùng chọn thư mục trên máy tính để lưu dữ 
liệu hoặc thực hiện các thao tác liên quan đến tệp tin. Khi chọn thư mục, hệ 
thống sẽ sử dụng đường dẫn được chọn để lưu hoặc truy xuất dữ liệu một 
cách chính xác. 

 Chức năng Thông Báo giúp hệ thống cung cấp cho người dùng các thông tin 
quan trọng hoặc cập nhật liên quan đến hoạt động của phần mềm. 

 

🟡 Đèn Vàng (Báo lỗi) 
●​ Dữ liệu gặp sự cố hoặc không thể tải về. 
●​ Người dùng cần liên hệ với đội ngũ DataPro để được hỗ trợ sớm nhất. 

🟢 Đèn Xanh (Tải dữ liệu thành công) 
●​ Dữ liệu đã được tải về đầy đủ. 
●​ Hệ thống đang hoạt động bình thường, không có lỗi. 

🔴 Đèn Đỏ (Dữ liệu đang cập nhật) 
●​ Hệ thống đang cập nhật dữ liệu mới nhất. 

 
Chức năng này cho phép người dùng đóng hoàn toàn ứng dụng 
DataPro một cách an toàn, đảm bảo không có dữ liệu nào bị mất 
hoặc lỗi khi thoát. 
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